Preface

Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©February 2006

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
AMD Turion™ is a trademark of Advanced Micro Devices, Inc.
is a trademark of SRS Labs, Inc. WOW technology is incorporated under license from SRS Labs, Inc.
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FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
•
•
•
•

Re orient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the service representative or an experienced radio/TV technician for help.


Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:
1.
2.
3.
4.
5.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.
Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.
Do not use the telephone to report a gas leak in the vicinity of the leak.
Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.
This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 11A minimum).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD
This Computer’s Optical Device is a Laser Class I Product
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:
1.

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.
Do not expose the computer
to any shock or vibration.

2.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

Do not expose it to excessive
heat or direct sunlight.

IV

Do not place it on an unstable
surface.

Do not leave it in a place where
foreign matter or moisture may
affect the system.

Don’t use or store the computer
in a humid environment.

Do not place the computer on
any surface that will block the
vents.
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3.

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

4.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power until
you properly shut down all programs.

5.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the computer by yourself.

Perform routine maintenance
on your computer.

Take care when using peripheral devices.
Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:


Power Safety
Warning
Before you undertake
any upgrade procedures, make sure that
you have turned off the
power, and disconnected all peripherals
and cables (including
telephone lines). It is
advisable to also remove your battery in
order to prevent accidentally turning the
machine on.

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady,
uninterrupted power supply. If you are unsure of your local power specifications, consult
your service representative or local power company.
• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong
is an important safety feature; do not defeat its purpose. If you do not have access to a
compatible outlet, have a qualified electrician install one.
• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
its wire.
• Make sure the socket and any extension cord(s) you use can support the total current load
of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).
Do not plug in the power
cord if you are wet.

VI

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:
•
•
•
•
•

When the power cord or AC/DC adapter is damaged or frayed.
If the computer has been exposed to rain or other liquids.
If the computer does not work normally when you follow the operating instructions.
If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations
Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:
1.
2.
3.
4.
5.
6.
7.
8.

Check that the battery pack and any spares are fully charged.
Power off the computer and peripherals.
Close the display panel and make sure it’s latched.
Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.
Put the notebook in its carrying bag and secure it with the bag’s straps.
If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.
Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.


Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:
Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.
Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.
Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.
Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.
Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

X

Preface

Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:
• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.
• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.
• Take periodic breaks if you are using the computer for long periods of time.
Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.
•
•
•
•

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.
Adjust the display-viewing angle to find the best position.
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Quick Start Guide

Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:
• Chapter 2

The Storage Devices (hard disk, optical device, Card Reader, PC Card), Mouse, Audio &
Printer.
• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software, or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth, TV Tuner and PC Camera modules
(some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A A definition of the interface, ports/jacks which allow your computer communicate with external
devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.


Notes
Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows XP etc.) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find this manual refers to the following operating systems:
•

Microsoft Windows XP Home & Professional Editions (with Service Pack 2)


Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 6. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “What
to Install” on page 4 - 1 for installation instructions.

Ports and Jacks
See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
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System Startup
1.
2.
3.

2

4.

5.

1
1.
2.

1

6.

LCD Latches
LED Power & Communication
Indicators

7.
8.

Remove all packing materials.
Place the computer on a stable surface.
Securely attach any peripherals you want to use with the
notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack at the rear of the
computer, then plug the AC power cord into an outlet, and
connect the AC power cord to the AC/DC adapter.
Move and hold the LCD latches 1 in the direction of the arrows
to release the top cover.
Raise the lid/LCD to a comfortable viewing angle, and press the
power button to turn the computer “on”.
Adjust the LCD panel to a comfortable viewing angle.
The LED indicators 2 show the power and battery status of the
computer.

Figure 1 - 1 - Top Panel with LCD Closed


Shutdown
Please note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command
from the Start menu in Windows. This will help prevent hard disk or system problems.
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System Map: Top View with LCD Panel Open
1



1.

Wireless Device
Operation Aboard
Aircraft

2

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the module(s) are OFF if you are
using the computer
aboard aircraft.
The key combination Fn
+ F11 toggles power to
the WLAN module, the
Ap-key
to the Bluetooth module.

3

6

5

4

4

7
8

Optional Built-In PC
Camera
2. LCD
3. LED Power &
Communication
Indicators
4. Speakers
5. AP-Key Buttons &
Power Button
6. Built-In Microphone
7. LED Status Indicators
8. Keyboard
9. TouchPad and Buttons
10. Consumer Infrared
Transceiver*

*Enabled

with Optional MiniPCI TV Tuner Only

5
9
10

7

Figure 1 - 2 - Top View with LCD Panel Open
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LED Indicators

Table 1 - 2 - LED Power & Communication Indicators

The two sets of LED indicators (LED Status Indicators and LED Power & Communication Indicators)
on the computer display helpful information about the
current status of the computer.

Icon

Color

Description

Orange

DC Power is Plugged In

Green

The Computer is On

Blinking Green

The Computer is in Stand by
Mode

Table 1 - 1 - LED Status Indicators
Icon

Color

Description
Orange

The Battery is Charging

Green

The (optional) PC Camera is
powered On

Green

The Battery is Fully Charged

Green

The (optional) Bluetooth Module
is powered On

Blinking Orange

The Battery Has Reached
Critically Low Power Status

Green

The (optional) Wireless LAN
Module is powered On

Blinking Green

New Mail Has Arrived

Green

Hard Disk Activity

Green

Number Lock Activated

Green

Caps Lock Activated

Green

Scroll Lock Activated (to activate
press Fn & Scr Lk)
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AP-Key Buttons

3D Ap-Key Button

These buttons power on/off the optional PC Camera
and Bluetooth modules, access the internet and e-mail,
and enable/disable high performance video.

Use this button to enable/disable high performance
video when powered by the AC/DC adapter (the 3D
Ap-Key button will be illuminated in blue when in
high performance video mode).

Table 1 - 3 - AP-Key Buttons
AP-Key

Function
Enable/Disable High Performance Video
Enable/Disable the optional
PC Camera Module
Enable/Disable the optional
Bluetooth Module

If you switch from AC Power to battery power the system will automatically change to a lower performance
video mode setting. High Performance Video can
not be enabled when the system is battery powered.
The system will retain in memory the last known video
performance setting if you switch back from battery to
AC power.

Function Keys & Numeric Keypad
Activate the Default E-mail Program
Activate the Default Internet Browser

The keyboard has an embedded numerical keypad for
easy numeric data input (see Figure 1 - 3 on page 1 8).
Activate the Number Lock feature by pressing the
Num Lk key at the top right of the keyboard. You may
check if Number Lock is enabled or not by looking at
the LED status indicators.

System Map: Top View with LCD Panel Open 1 - 7
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Table 1 - 4 - Function Keys
Keys

Description

Fn

Function Key

Fn + F1

TouchPad Toggle

Fn + F2

Figure 1 - 3 - Keyboard

Function Keys

SRS WOW Surround
Sound Toggle

Num Lk & Scr Lk Keys
Numeric
Keypad

Fn + F3

Mute Toggle

Fn + F4

Sleep Toggle

Fn + F5

Decrease Audio Volume

Fn + F6

Increase Audio Volume

Fn + F7

Display Toggle



Fn + F8

Decrease LCD Brightness

Other Keyboards

Fn + F9

Increase LCD Brightness

Fn + F11

WLAN Module Toggle

Fn + Scr
Lk

If your keyboard is damaged or you just want to make a change, you can use
any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.

Scroll Lock Toggle

Fn Key

1 - 8 System Map: Top View with LCD Panel Open
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System Map: Front & Rear Views
1

Figure 1 - 4
Front & Rear Views

1
2
1.


Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s)
while the computer is in use.

3

4

5

6

LCD Latches
Consumer Infrared
Transceiver*
3. 7-Pin S-Video-Out
Jack
4. DVI-Out Port
5. DC-In Jack
6. Vent/Fan Intake
7. RJ-11 Phone Jack
8. 2 * USB 2.0 Ports
9. Serial Port
10. S-Video-In Jack*
11. Security Lock Slot

2.

7 8

9

10

11

*Enabled

3

3

with Optional Mini-

PCI TV Tuner Only


7-Pin S-Video-Out Jack
The 7-pin S-Video Out Jack requires an adapter cable (7-pin S-Video plug
to 4-pin S-Video jack adapter) in order to connect to a standard S-Video cable (the y-cable pictured includes a yellow composite video jack).

S-Video/Composite Cable

HDTV Cable

System Map: Front & Rear Views 1 - 9
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System Map: Left View
Figure 1 - 5
Left View
1.
2.
3.
4.
5.

S/PDIF-Out Jack
Line-In Jack
(see page A - 3)
Microphone-In Jack
Headphone-Out Jack
Optical Device Drive Bay
(for CD/DVD Device)

1 2 3 4


CD Emergency Eject
If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a
sharpened pencil or similar object that may break and become
lodged in the hole.

Media Warning
Don’t try to remove a floppy disk/CD/DVD while the system is
accessing it. This may cause the system to “crash”.

1 - 10 System Map: Left View
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Changing DVD Regional Codes
Go to the Control Panel and double-click System >
Hardware (tab), click Device Manager, then click
the + next to DVD/CD-ROM drives. Double-click on
the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to
bring up the control panel to allow you to adjust the
regional code (see “DVD Regional Codes” on
page 2 - 5).
DVD region detection is device dependent, not OSdependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
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System Map: Right View
Figure 1 - 6 - Right View

1

2

3

3

3

4

5

6

7



1.
2.
3.
4.
5.
6.

4-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro
(Memory Stick Pro)

7.

PC Card Slot
Mini-IEEE 1394a Port
3 * USB 2.0 Ports
TV Antenna Jack*
4-in-1 Card Reader
Infrared Transceiver
(see page 2 - 12)
RJ-45 LAN Jack

*Enabled

with Optional Mini-PCI TV
Tuner Only

Mini-IEEE 1394a
The Mini-IEEE 1394a port only supports SELF POWERED IEEE 1394a devices.

System Map: Right View 1 - 11
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System Map: Bottom View
Figure 1 - 7 - Bottom View
1.
2.
3.
4.
5.
6.
7.
8.

Battery
Battery Release Latch
CD/DVD Device Release Latch
Hard Disk Bay Cover
Vent/Fan Intake
Sub Woofer
Component Bay Cover
Speakers

2

5

5

5

1

7

5

5



5

CPU

5
5

The CPU is not a user serviceable part. Opening this
compartment, or accessing the CPU in any way, may violate your warranty.

8

3

6
4

8


Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery
at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instructions.

1 - 12 System Map: Bottom View
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP are accessed from the Start menu. When
you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be
placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking
the Start menu and selecting Properties from the menu.

Figure 1 - 8
Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu. The Control Panel allows you to configure the settings for most of the
key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic control panels for
many of the features, however many new control panels are added (or existing ones are enhanced) when you
install the drivers listed in Table 4 - 1, on page 4 - 6. To see all controls it may be necessary to toggle off Category View.

Windows XP Start Menu & Control Panel 1 - 13

1
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Video Features
This computer features an NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs in a single system to allow the two graphics cards to run in parallel.
You can switch display devices, and configure display options, from the Display Properties control panel in
Windows as long as the appropriate video driver is installed.
To access Display Properties in Windows:
1.
2.
3.

4.
5.
6.
7.
8.

Click Start, point to Settings and click Control Panel (or just click Control Panel).
Double-click Display (icon) - In the Appearances and Themes category.
Click Settings (tab) in the Display Properties dialog box.
(You can also access Display Properties by right-clicking the desktop and scrolling down and clicking
Properties. Click Settings and adjust as above.)
Move the slider to the preferred setting in Screen area/resolution 1 (Figure 1 - 9 on page 1 - 15).
Click the arrow, and scroll to the preferred setting In Colors/Color quality 2 (Figure 1 - 9 on page 1 - 15).
Click Advanced (button) 3 (Figure 1 - 9 on page 1 - 15) to bring up the Advanced properties tabs.
Click GeForce Go ... (tab).
Clicking the tabs or Additional Properties allows you to make any video adjustments you require.

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV as your display device (Note: SLI Multi-GPU supports only single display mode). A VGA monitor/Flat
Panel Display connects to the DVI-Out port, a TV to the S-Video-Out jack. See Table 1 - 9 on page 1 - 15 for
a summary of the display modes available, and see “NVIDIA Video Driver Controls” on page B - 1 for more
detailed video information.

1 - 14 Video Features
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1

2
3

Figure 1 - 9 - Display Properties Desktop
Display Mode

Description

Single

One of the connected displays is used as the display device

Clone*

Both connected displays output the same view

Dualview*

Both connected displays are treated as separate devices, and act as a virtual desktop

Table 1 - 5
Display
Options

*Note: SLI Multi-GPU supports only single display mode (disable SLI Multi-GPU before switching to
Clone or Dualview modes).

Video Features 1 - 15

1

1

Quick Start Guide

Power Management Features
The Power Options control panel in Windows (see page 1 - 13) allows you to configure power management
features for your computer. You may conserve power through individual components such as the monitor or hard
disk (by means of Power Schemes), or you may use either Stand by or Hibernate mode to conserve power
throughout the system (enable Hibernate support from the control panel as pictured in Figure 1 - 10). Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

Figure 1 - 10 - Power Options

The computer’s power button, sleep button (Fn + F4 key combination), and lid (closing the lid) may be set to
send the computer in to either Stand by or Hibernate mode.
Power Saving and Performance
Power Schemes may have an affect on your computer performance (see “Power Schemes” on page 3 - 4).

1 - 16 Power Management Features
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Chapter 2: Storage Devices, Mouse, Audio &
Printer
Overview
Read this chapter to learn more about the following main features and components
of the computer:
•
•
•
•
•
•
•
•
•

Hard Disk Drive
Optical Device
4-in-1 Card Reader
PC Card Slot
Auto Mail Checker
TouchPad and Buttons/Mouse
Audio Features
Configuring the Infrared Settings for FIR
Adding a Printer

Overview 2 - 1
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Power Safety
Before attempting to access any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the machine is turned off. Also
ensure that all peripheral cables, including
phone lines, are disconnected from the computer.

Figure 2 - 1
Hard Disk Location

2 - 2 Hard Disk Drive

Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA II) hard disk drives with a height
of 9.5 mm. The hard disk 1 is accessible from the bottom of your computer as seen
below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 4.

1
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage Options” on page C 3). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator 2 will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole
3 to open the tray.

2

1


Sound Volume
Adjustment
How high the sound volume can be set depends
on the setting of the volume control within Windows. Click the Volume
icon on the taskbar to
check the setting.
Peripherals must be
connected before you
turn on the system.

Figure 2 - 2
3

Optical Device

Optical Device 2 - 3
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Handling CDs or DVDs


CD Emergency Eject
If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharpened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning
Don’t try to remove a
CD/DVD while the system is accessing it. This
may cause the system
to “crash”.

2 - 4 Optical Device

Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.
Note the following:
•
•
•
•
•
•
•
•

Hold the CD or DVD by the edges; do not touch the surface of the disc.
Use a clean, soft, dry cloth to remove dust or fingerprints.
Do not write on the surface with a pen.
Do not attach paper or other materials to the surface of the disc.
Do not store or place the CD or DVD in high-temperature areas.
Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
Do not bend the CD or DVD.
Do not drop or subject the CD or DVD to shock.

Storage Devices, Mouse, Audio & Printer

DVD Regional Codes

2

To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 10.
.

DVD Regional Coding

Table 2 - 1
Region

Geographical Location

1

USA, Canada

2

Western Europe, Japan, South
Africa, Middle East & Egypt

3

South-East Asia, Taiwan, South
Korea, The Philippines, Indonesia,
Hong Kong

4

South & Central America, Mexico,
Australia,
New Zealand

5

N Korea, Russia, Eastern Europe,
India & Most of Africa

6

China

DVD Regional Coding

Figure 2 - 3
DVD Regions

Optical Device 2 - 5

Storage Devices, Mouse, Audio & Printer

2


Card Reader Cover
Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust getting in to the card reader.

4-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device.
•
•
•
•

MMC (MultiMedia Card)
SD (Secure Digital)
MS (Memory Stick)
MS Pro (Memory Stick Pro)

Figure 2 - 4
Right View
1.

Card Reader

2 - 6 4-in-1 Card Reader

1
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PC Card Slot

2

The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC Card.

Inserting and Removing PC Cards
• Align the PC Card with the slot and push it in until it locks into place.
• To remove a PC Card, simply press the eject button 1 next to the slot.

1

Figure 2 - 5
PC Card Slot

PC Card Slot 2 - 7

Storage Devices, Mouse, Audio & Printer

Auto Mail Checker

2

After you have installed the driver for the Auto Mail Checker program (see “AutoMail Checker” on page 4 - 11) you may then configure it to give you notification
when you receive new mail. You must be online to receive this notification (note that
this program only supports the POP3 protocol), and your default mail program does
not need to be open.
When the program is run, the Auto Mail Checker appears as an icon
in the taskbar (to run the program go to Start > Programs/All Programs > Auto Mail
Checker > Auto Mail Checker). Right clicking on the icon will bring up the following options menu. If you have not input your mail account data, then you will be
prompted to do so.

Figure 2 - 6
Auto Mail Checker

Select Open to bring up the control panel for the program.

2 - 8 Auto Mail Checker

Storage Devices, Mouse, Audio & Printer
You may then configure the options for your mailserver, name, password, program
and method(s) of notification.


Note
Check with your Internet
Service Provider, network administrator or
Mail Service provider for
details on what to put on
these pages.

Figure 2 - 7
Auto Mail Checker
Account Setup and
Options

Auto Mail Checker 2 - 9
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Mouse Driver
If you are using an external mouse your operating system may be able
to auto-configure your
mouse during its installation or only enable its
basic functions. Be sure
to check the device’s
user documentation for
details.

TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. The central button may be configured to
function as you require.
Once you have installed the TouchPad driver (see page 4 - 10) you can configure the
functions by double-clicking the TouchPad driver icon
in the taskbar. You may
then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. The TouchPad may be toggled on/off by means
of the Fn + F1 key combination.

Figure 2 - 8
Mouse Properties

2 - 10 TouchPad and Buttons/Mouse
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio
Devices
Windows control panel (see Figure 1 - 8 on page 1 - 13), or from the
Sound Manager
icon in the taskbar/control panel (this will bring up the AC97
Audio Configuration menu). Adjust the volume by using the Fn + F5/F6 key combination.
The audio system features SRS WOW Surround Sound
Technology inside
(SRS/ TruSurround/ TruBass / Focus Enhancement). SRS WOW Surround Sound
may be toggled on/off using the Fn + F2 key combination.


Sound Volume
Adjustment
How high the sound volume can be set depends
on the setting of the volume control within Windows. Click the Volume
icon on the taskbar to
check the setting.

Note that audio input through Line-in will default to the mute setting. To set up your
audio sources to play though the Line-in jack go to the Sounds and Audio Devices
Windows control panel and make sure the Mute box is not ticked.

Figure 2 - 9
AC97 Audio
Configuration
Menus

Audio Features 2 - 11
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Infrared
Communication
The infrared transceiver
operates on a “Line of
Sight”.
Make sure nothing is
blocking the “Line of
Sight” between your
system’s
transceiver
and the destination’s
transceiver.

Configuring the Infrared Settings for FIR
To configure your computer’s infrared port (on the right of the computer) for Far Infrared (FIR) communication follow these steps:
1.
2.
3.
4.
5.
6.

Click Start, point to Settings and click Control Panel (or just click Start > Control
Panel).
Double-click Wireless Link (Printers and Other Hardware Category) icon.
Click Hardware (tab), and click the Properties button, then click the Advanced
(tab).
Select “Infrared Transceiver A” and change the Value to “HP HSDL-2300/
3600”.
Click OK > OK.
Restart the computer if prompted to do so.

You can enable/disable the infrared transceiver in the BIOS (see “I/O Device Configuration (Advanced Menu)” on page 5 - 9). For further information, please refer
to the manual of the device you wish to connect.

2 - 12 Configuring the Infrared Settings for FIR
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer, however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1.
2.
3.
4.
5.

Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
Turn ON the computer.
Turn ON the printer.
Connect the printer’s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).


Parallel Printer
After setting up the printer attach the parallel cable to the printer.
Connect the printer’s
parallel cable to the Parallel to USB converter,
and then plug the converter into the USB port.
Turn ON the printer,
then turn ON the computer.
Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen instructions.

Adding a Printer 2 - 13
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer uses the ACPI
power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole
system.
This chapter covers:
•
•
•
•
•
•

The Power Sources
Turning on the Computer
Power Schemes
System Power Options
Configuring the Power Button
Battery Information


OS Note
Power
management
functions will vary slightly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operating system.
(Note: All pictures used
on the following pages
are from the Windows
XP OS.)

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques
and gives the operating system (OS) direct control over the power and thermal states
of devices and processors. For example, it enables the OS to set devices into lowpower states based on user settings and information from applications. ACPI is fully
supported in Windows XP.

Overview 3 - 1
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Power Button as
Stand by or
Hibernate Button
If you are using a fully
ACPI-compliant
OS,
(such as Windows XP)
you can use the OS’s
“Power Options” control
panel to set the power
button to send the system into Stand by or Hibernate mode (see your
OS’s documentation, or
“Configuring the Power Button” on page 3 8 for details).

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page C - 5).
1.
2.
3.
4.

Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.
Raise the lid/LCD to a comfortable viewing angle.
Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 12).
We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 9.

3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.




Shutdown
Note that you should always shut your computer down by choosing the
Shut Down/Turn Off
Computer
command
from the Start menu in
Windows. This will help
prevent hard disk or system problems.

Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Turning on the Computer 3 - 3
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Resuming
Operation
Press a key on the keyboard to have the system
resume
from
Monitor or Hard Disk
Stand by.

Figure 3 - 1
Power Schemes

3 - 4 Power Schemes

Power Schemes
You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Stand by or
Hibernate modes (see “System Power Options” on page 3 - 6).

Power Management
Each Windows Power Scheme will also adjust the processor performance of your
machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

3

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC power source. Choose the Max Battery scheme (bear
in mind that this scheme may slow down the overall performance of the computer in
order to save power) for maximum power saving when the computer is battery (DC
power) powered.
Windows will use Portable/Laptop as the default scheme.

Power Schemes 3 - 5
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System Power Options
3

You can use the system power options to stop the computer’s operation and restart
where you left off. This system features Stand by and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hibernate
tab in the Power Options control panel - Figure 3 - 2 on page 3 - 7).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need
to press the power button to turn it on. Their main difference is:
When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.
You can use either method depending on your needs.

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on
Stand by instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Stand by mode.

3 - 6 System Power Options
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full
operation. During Stand by the hard disk is turned off, and the CPU is made to idle
at its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Stand by mode to save power.


System Resume
The system can resume
from Stand by mode by:

• Pressing the power
button

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The
system will resume from Hibernate mode by pressing the power button.

• Pressing the Fn + F4
key combination
• An alarm resume that
is
enabled
and
expires
• An incoming call
received
on
the
modem (if enabled)
• Network card activity (if enabled)

Figure 3 - 2
Enable Hibernation

System Power Options 3 - 7
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hibernate mode. In Stand by mode, the LED
will blink green. In Hibernate mode
the LED will be off. If you are in a power saving mode set to save power through
individual components (e.g. hard disk, monitor), the LED will remain green.

3

Figure 3 - 3
Power Options
(Advanced - Power
Buttons)

Power Button

Lid

Sleep/Resume (Sleep) Button


Sleep Button
You may also configure the Sleep/Resume key combination (Fn + F4) from the menu illustrated in Figure 3 - 3. In Windows this is referred to as the Sleep button.

3 - 8 Configuring the Power Button
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Battery Information



Please follow these simple guidelines to get the best use out of your battery.

Low Battery
Warning

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 12 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may
set low battery Alarms and actions, and check the Power Meter from the Power
Options control panel), and settings in the OS will help prolong the battery life if
configured appropriately.

When the battery is critically low, immediately
connect the AC/DC
adapter to the computer
or save your work, otherwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 4
Power Options
(Alarm & Power
Meter)

Battery Information 3 - 9
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Conserving Battery
Power
To conserve battery power:
Lower the brightness level
of the LCD display. The
system will decrease LCD
brightness slightly to save
power when it is not powered by the AC/DC adapter.
Close modem or communication applications when
they are not being used.
Remove any unused PC
Cards from the computer
(PC Cards quickly use up
battery power even if the
system
enters
sleep
mode).
Disconnect any unnecessary external devices.

Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.
We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.
3D Ap-Key Button
The system will default to high performance video when powered by the AC/DC
adapter (the 3D Ap-Key button will be illuminated in blue). If you switch from AC
power to battery power the system will automatically change to a lower performance
video mode setting in order to save power. High Performance Video can not be
enabled when the system is battery powered (see “3D Ap-Key Button” on page 1
- 7).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 6 for information on the battery charge status, and to “Battery Information” on page 3 - 9 for more information on how to maintain and properly
recharge the battery pack.)

3 - 10 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

3


Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ


3

Caution
Danger of explosion if
battery is incorrectly replaced.
Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s instructions.

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer by yourself even when you see a message that indicates the
battery is critically low, just let the computer use up all of the battery power and shut
down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms (unclick the tickboxes - see 3 - 9) and Schemes (change all the
settings to Never - see page 3 - 4). As the battery nears the end of its life save and
close any critical files.
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.
How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or improvement of some
of the computer’s subsystems. The system takes advantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to
manually install some system-required drivers and
utilities.The following operating system is covered.

What to Install
The Device Drivers & Utilities + User’s Manual CDROM contains the drivers and utilities necessary for
the proper operation of the computer. The drivers for
all the modules (WLAN, Bluetooth, PC Camera and
TV Tuner) are on the separate CD-ROMs supplied.
Table 4 - 1 on page 4 - 6 lists what you need to install
manually according to your choice of the operating
system, and it is very important that the drivers are
installed in the order indicated.

Module Driver Installation
• Windows XP Professional and Home Editions
(with Service Pack 2)

The procedures for installing drivers for the Wireless
LAN, Bluetooth, TV Tuner, and PC Camera modules are provided in “Modules” on page 7 - 1. Make
sure that the drivers are installed in the order indicated
in Table 4 - 1 on page 4 - 6.

What to Install 4 - 1
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Navigate (Browse..) to D:
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You will notice that many of the instructions for driver
installation require you to “Navigate (Browse) to D:”.
We assume that you will install all drivers and utilities
from the built-in CD device and it is assigned to “Drive
D:”. In addition, all file extensions can be seen
In this case “D:” is the drive specified for your CD device. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.
When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” dialog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.
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Service Packs
Check the warnings on the following pages regarding
installation of the appropriate Service Pack for your
Windows OS. If you are unsure of the Service Pack
currently installed see below. Make sure you have installed the appropriate Service Pack before installing
all the drivers.


Service Pack Installed
To see which Service Pack is currently installed on your
computer go to the General tab of the System control
panel. Right-click the My Computer icon on the desktop
or in the Start menu and select Properties. The Service
Pack currently installed on your system will be listed under the “System:” heading. (If no Service Pack information is listed, then no Service Pack is installed.)


Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or
a Windows XP version which includes Service Pack 2)
before installing any drivers. Service Pack 2 includes
support for USB 2.0.
If you have upgraded the system by installing Service
Pack 2 (i.e. your Windows XP version does not include
Service Pack 2) then follow these instructions:
1.Click Start (menu), point to Settings and click Control
Panel (or click Control Panel).
2.Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3.Click the Hardware (tab) > Device Manager (button).
4.Click “+” next to Other Devices (if its sub-items are not
shown).
5.Right-click Universal Serial Bus (USB) Controller
and select Uninstall > OK (if you don’t see the item
then there is no need to take any further action).
6.Restart the computer and it will find the USB 2.0 controller.
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Authorized Driver Message

Updating/Reinstalling Individual Drivers

If you receive a message telling you that the driver you
are installing is not authorized (Digital Signature Not
Found), just click Yes or Continue Anyway to ignore
the message and continue the installation procedure.

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Add/Remove Programs item. If you
see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be
necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

You will receive this message in cases where the driver has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file
version conflict” message, please click Yes to choose
to keep the existing (newer) version.

If the driver is not listed in the Add/Remove Programs item:
1.
2.
3.
4.
5.

4 - 4 What to Install

Click Start (menu), point to Settings and click Control
Panel (or click Start > Control Panel).
Double-click System (icon); System (icon) is in
Performance and Maintenance (category).
Click Hardware (tab) > Device Manager (button).
Double-click the device you wish to update/reinstall the
driver for (you may need to click “+”).
Look for the Update Driver button (check the Driver tab)
and follow the on screen prompts.

Drivers & Utilities

Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM and the Notebook Driver Installation application will run automatically. If you want to install the
driver manually see Page 4 - 6.
1.

2.
3.
4.
5.

6.

Check the driver installation order from Table 4 - 1
on page 4 - 6 (the drivers must be installed in
this order) which is the same as that listed in the
driver installation screen menu.
Double-click to select the name of the driver you
wish to install.
Follow the instructions as listed in this chapter.
Make a note of the drivers you have installed.
If a restart is required after installing a driver, you
will usually need to click the “Yes/Finish” button
when prompted to restart the computer.
To get back to the Notebook Driver Installation
screen click Start (menu) > Run... and navigate
(Browse..) to D:\setup.exe and click OK.
OR
Double-click the My Computer icon, and then
double-click the CD icon.

4

Figure 4 - 2
Driver Installation Screen
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Windows XP (SP2)
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Driver

Page

Driver

Page

Chipset

Page 4 - 7

PCMCIA

Page 4 - 10

Video (VGA)

Page 4 - 7

AMD Processor

Page 4 - 10

Audio

Page 4 - 8

AutoMail Checker

Page 4 - 11

Modem

Page 4 - 8

PC Camera Module

Page 7 - 2

LAN

Page 4 - 9

WLAN Module

Page 7 - 9 OR Page 7 - 10

AP-Key Buttons

Page 4 - 9

Bluetooth Module

Page 7 - 12

TouchPad

Page 4 - 10

TV Tuner Module

Page 7 - 15

Table 4 - 1 - Driver Installation

Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Notebook Driver Installation application, and then follow the manual installation procedure for each driver. The manual installation procedure begins with instructions on how to browse to the executable file; “Click Start (menu) > Run..”.
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Windows XP
Driver Installation Procedure
This section covers driver and utility installation instructions for Windows XP Home & Professional. Insert the Device Drivers & Utilities + User’s Manual
CD-ROM and click the appropriate driver name from
the NoteBook Driver Installation menu and follow
the instructions to install the driver, or Click Start and
navigate (Browse..) to follow the manual setup instructions.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installation procedure (other than when outlined in the
driver install procedure), click Cancel to close the
window, and follow the installation procedure.

Chipset
1. Double-click Chipset.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\00CHIPSET\setup.exe and click
OK.
2. Click Next > Next > Next > Yes.
3. Click Finish to restart the computer.
Video (VGA)
1. Double-click VGA.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\01VGA\setup.exe and click OK.
2. Click Next (click Continue Anyway if asked if
you want to continue at any time).
3. Click Finish to restart the computer.

Windows XP 4 - 7
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Audio
1. Double-click Audio.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\02AUDIO\setup.exe and click
OK.
2. Click Next.
3. Click Finish to restart the computer.

Modem
1. Double-click Modem.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\03MODEM\Setup.exe and click
OK.
2. Click OK > OK.
3. The modem is now ready for configuration.


Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem
Options).
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LAN
1. Double-click Lan.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\04LAN\SetupYukonWin.exe and
click OK.
2. Click Next.
3. Click the button to accept the license and click
Next.
4. Click Install > Finish.
5. The network settings can now be configured.

AP-Key Buttons
1. Double-click AP-key.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\05AP-Key\AKSETUP.exe and
click OK.
2. Click Next.
3. Click Finish to restart your computer.
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TouchPad
1. Double-click Touchpad.
OR
Click Start (menu) > Run... and navigate
(Browse...) to
D:\Drivers\06TOUCHPAD\setup.exe and
click OK.
2. Click Next > Next (click Continue Anyway if
asked if you want to continue at any time).
3. Click Finish to restart your computer.
4. You may then configure your TouchPad as outlined in “TouchPad and Buttons/Mouse” on
page 2 - 10.
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PCMCIA
1. Double-click PCMCIA.
OR
Click Start (menu) > Run... and navigate
(Browse..) to D:\Drivers
\07PCMCIA\setup.exe and click OK.
2. Click Next.
3. Click Finish.
AMD Processor
1. Double-click AMD.
OR
Click Start (menu) > Run... and navigate
(Browse..) to
D:\Drivers\08AMD\setup.EXE and click OK.
2. Click Next > Yes > Next > Next.
3. Click the button “Yes, I want to restart the
computer now.”, and click Finish to restart the
computer.
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AutoMail Checker
1. Double-click AUTOMAIL.
OR
Click Start (menu) > Run... and navigate
(Browse..) to D:\Drivers\
09AUTOMAIL\SETUP.EXE and click OK.
2. To continue click Next > Next > Finish.
3. Run the program from the Auto Mail Checker
in the Start menu (Start > Programs/All Programs > Auto Mail Checker).
4. Click the icon
in the taskbar to input the email account details.
5. For further details see “Auto Mail Checker” on
page 2 - 8.

Module Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

PC Camera
See the install procedure in “PC Camera Module” on
page 7 - 2.

Wireless LAN
See the appropriate install procedure for your WLAN
module in either “Intel WLAN Driver Installation”
on page 7 - 9, or “MSI 6833B WLAN Driver Installation” on page 7 - 10.

Bluetooth
See the install procedure in “Bluetooth Driver Installation” on page 7 - 12.

TV Tuner
See the install procedure for your TV Tuner module in
“Installing the AverTV Utility Software” on page 7 15.
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software:
Diagnostics: The POST (Power-On Self Test)
Configuration: The Setup utility
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your
system ever needs servicing.


BIOS Settings
Warning
Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Setup and restore the Setup Defaults with <F9>.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

Overview 5 - 1
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POST Screen

5

1.BIOS information
2.CPU type
3.Memory status
4.Enter Setup prompt
appears only during
POST
Note: The POST screen
as pictured is for guideline purposes only.

Figure 5 - 1
POST Screen

The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).
As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.
If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.
1

Phoenix FirstBIOS Desktop Pro
Copyright 1985-2004 Phoenix Technologies Ltd.
All Rights Reserved
BIOS Revision: 1.00.P:02a
KBC/EC Revision: 1.00.D05a
CPU0 = AMD Athlon(tm) 64 Mobile Technology MT-30
CPU Stepping = E4 1600MHz
633K System RAM Passed
510M Extended RAM Passed
1024K Cache SRAM Passed
System BIOS shadowed
Video BIOS shadowed
ATAPI CD-ROM: UJDA770 DVD/CDRW
Fixed Disk 0: FUJITSU MHT2060BH
Mouse intialized

3

Press <F2> to enter SETUP

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “nonfatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:
• Press <F1> to resume
• <F2> to enter Setup
Press F1 to see if the boot process can continue. It may work, without the correct
configuration.
Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

5

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usually
because you pressed F2 too quickly) just press F2 again.
If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Program
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Setup Screens



The following pages contain additional advice on portions of the Setup.

Setup Menus

Along the top of the screen is a menu bar with five (5) menu headings. When you
select a heading, a new screen appears. Scroll through the features listed on each
screen to make changes to Setup.
Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The
Setup
menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configuration appropriate for your
model and options.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.
If you see an arrow next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

The Setup Program 5 - 5

5

BIOS Utilities

Main Menu
Figure 5 - 2
Main Menu

PhoenixBIOS Setup Utility
Main
Main

Advanced

Boot

Primary Master
SATA Port 4

634 KB
510 MB

VGA Card:
VBIOS Revision
VBIOS Build Date

nVIDIA 7800 GTX
5.70.02.24.C3
11/22/05

Help
Exit

Item Specific Help

[UJDA770 DVD/CDRW-(PM)]
[FUJITSU MHT2060BH-(S4)]

System Memory:
Extended Memory:

F1
Esc

Exit

[22:11:05]
[12/30/2005]

System Time:
System Date:

5

Security




Select Item
Select Menu

-/+
Enter

<Tab>, <Shift Tab>, or
<Enter> selects field.

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.
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Primary Master/SATA Port 4 (Main Menu)
Pressing Enter here opens the sub-menu to show the configuration of hard disks and
CD/DVD device(s) on the computer’s IDE Channels. Use the Auto (Type:) setting
to have the items configured automatically for you.
System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

5

The Main menu also contains information on your video card and video BIOS version.
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Advanced Menu
Figure 5 - 3
PhoenixBIOS Setup Utility

Advanced Menu
Advanced
Advanced

Main

Security

Power

Boot

Exit
Item Specific Help

Advanced Chipset Control
I/O Device Configuration

5

Reset Configuration Data:
Power on Boot Beep
Battery Low Alarm Beep:

F1
Esc

Help
Exit




Select Item
Select Menu

[No]
[Disabled]
[Enabled]

-/+
Enter

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

Advanced Chipset Control (Advanced Menu)
Pressing Enter here will access the sub-menu which allows you to disable the audio
and modem devices if required.
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I/O Device Configuration (Advanced Menu)
The sub-menus under this item allow you to enable/disable the Serial port A (Serial
Mouse), and FIR (Infrared) transceiver.
Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

5

Power On Boot Beep (Advanced Menu)
Use this menu to enable/disable the single beep sound at the end of the POST. This
item is “Disabled” by default.
Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu
Figure 5 - 4

PhoenixBIOS Setup Utility

Security Menu
Main

Advanced

Security
Security

Boot

Exit
Item Specific Help

5

Supervisor Password Is:

Clear

Set Supervisor Password

[Enter]

Password on boot:

[Disabled]

Supervisor Password
controls access to the
setup utility.


Security Menu
The changes you
make here affect the
access to the Setup
utility itself, and also
access to your machine as it boots up after you turn it on.
These settings do not
affect your machine or
network
passwords
which will be set in
your software OS.
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Select Item
Select Menu

-/+
Enter

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to
the computer OS, (only the Setup utility) unless you choose to set a Password on
Boot (see over).

BIOS Utilities
Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see
the warning in the sidebar). The default setting is “Disabled”.
Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.


Password Warning
If you set a boot password (Password on boot
is “Enabled“), NEVER
forget your password.
The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your vendor and you may lose all
of the information on
your hard disk.

Security Menu 5 - 11
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Boot Menu
PhoenixBIOS Setup Utility

Figure 5 - 5
Boot Menu

Main

Advanced

Security

Boot

Exit
Item Specific Help

Boot priority order:
1: IDE 7:
FUJITSU MHT2060BH-(S4)
2: USB FDC:
Y-E DATA USB-FDU-(USB 1.1
3: IDE CD:
UJDA770 DVD/CDRW-(PM)
4: PCI BEV:
B3 DO YUKON PXE
5: USB KEY:
6:
7:
8:
Excluded from boot order:
: USB CDROM:
: USB HDD:
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F1
Esc

Help
Exit




Select Item
Select Menu

-/+
Enter

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<f> and <r> specifies
the device fixed or
removable.
<x> exclude or include
the device to boot.
<Shift + 1> enables or
disables a device.
<1 - 4> Loads default
boot sequence.

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

When you turn the computer on it will look for an operating system (e.g. WindowsXP) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

5 - 12 Boot Menu

BIOS Utilities

Exit Menu
Figure 5 - 6

PhoenixBIOS Setup Utility
Main

Advanced

Security

Boot

Exit Menu

Exit
Exit
Item Specific Help

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

F1
Esc

Help
Exit




Select Item
Select Menu

[Enter]
[Enter]
[Enter]
[Enter]
[Enter]

-/+
Enter

Exit System Setup and
save your changes to
CMOS.

Change Values
Execute Command
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F9 Setup Defaults
F10 Save and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Setup defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:
• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap


Warranty Warning
Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the components.
The chapter includes:
•
•
•
•
•

Removing the Battery
Upgrading the Hard Disk Drive(s)
Upgrading the System Memory (RAM)
Upgrading the Optical (CD/DVD) Device(s)
Removing the Video Card(s)

Please make sure that you review each procedure before you perform it.

Overview 6 - 1
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When Not to Upgrade


Power Safety Warning

6

Before you undertake
any upgrade procedures, make sure that
you have turned off the
power, and disconnected all peripherals and
cables (including telephone lines). It is advisable to also remove your
battery in order to prevent accidentally turning
the machine on.

These procedures involve opening the system’s case, adding and sometimes replacing parts.You should not perform any of these upgrades if:
•
•
•
•

Your system is still under warranty or a service contract
You don’t have all the necessary equipment
You’re not in the correct environment
You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).


Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1.
2.
3.

Turn the computer off, turn it over and remove the battery.
Slide latch 1 towards the unlock symbol and hold it in place, and slide latch 2 in
the direction of the arrow.
Slide the battery 3 out and lift it up and out of the battery bay.


Warranty Warning
Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
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Battery Removal

3
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HDD System Warning

6

New HDD’s are blank. Before you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to install your operating system
and programs.
If you have access to the internet, download the latest
application and hardware
driver updates for the operating system you plan to install. Copy these to a
removable medium.

Upgrading the Hard Disk Drive(s)
The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA II)
hard disk drives with a height of 9.5mm (h) (see “Storage Options” on page C - 3).
Follow your operating system’s installation instructions, and install all necessary
drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting
up a new hard disk.
1.
2.
3.

Turn off the computer, and turn it over and remove the battery.
Locate the hard disk bay cover and remove screws 1 - 3 .
Remove the bay cover 4 .

Figure 6 - 2
HDD Bay Cover
Removal

1
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Upgrading The Computer
4.
5.
6.
7.

Slide the hard disk assembly in the direction of the arrow 5 .
Remove the hard disk assembly 6 .
Remove screws 7 - 10 and separate the bracket 11 from the hard disk 12 .
Reverse the process to install a new hard disk(s).
10

9

5

11

Figure 6 - 3
7

HDD Removal

8
12

6
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SODIMM) DDR type memory modules (see “Memory” on page C - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.
1.
2.

Turn off the computer, and turn it over and remove the battery.
Locate the component bay cover and remove screws 1 - 13 .

6
1

4

3

2

5

Figure 6 - 4
Bay Cover Screws

8

9

7

11

10
13
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3.

Remove the bay cover 14 .

Figure 6 - 5
Bay Cover Removal


14

4.

Contact Warning

Gently pull the two release latches ( 15 & 16 ) on the sides of the memory socket in
the direction indicated by the arrows in Figure 6 - 6.

Be careful not to touch
the metal pins on the
module’s
connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 6
15

16

RAM Module
Release
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5.

The RAM module 17 will pop-up, and you can remove it.

Figure 6 - 7
RAM Removal

17

6

6.
7.

Pull the latches to release the second module if necessary.
Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory socket.
8. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the socket as it will go. DO NOT FORCE the module; it should
fit without much pressure.
9. Press the module in and down towards the mainboard until the socket levers click
into place to secure the module.
10. Replace the cover and screws (see Figure 6 - 4).
11. Restart the computer to allow the BIOS will register the new memory configuration
as it starts up.
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Upgrading the Optical (CD/DVD) Device(s)
1.
2.
3.

Turn the computer off, turn it over and remove the battery.
Slide the latch 1 towards the unlock symbol and hold it in place.
Slide the optical device out of the computer at point 2 .

6

2
1

Figure 6 - 8
Removing the CD/
DVD Device(s)
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Removing the Video Card(s)
1.
2.
3.

Turn off the computer, and turn it over and remove the battery.
Locate the component bay cover and remove screws 1 - 13 .
Remove the bay cover 14 .

1

Figure 6 - 9
Bay Cover Removal

4

7

8

9

6

3

2

10

11
13

14
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4.
5.
6.

Remove screws ( 15 & 18 ).
Carefully (a cable is still connected) grip the plastic tag and lift the video card up.
Disconnect cable 19 , and lift the video card off the computer.


Caution

19

19
15

16

The heat sink, and video
card area in general,
contains parts which are
subject to high temperatures. Allow the area
time to cool before removing these parts.

16

15

Figure 6 - 10
Video Card Removal

18

17

18

17
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Chapter 7: Modules
Overview
This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.
The chapter includes information on the following:
•
•
•
•

PC Camera Module
Mini-PCI Wireless LAN Module
Bluetooth Module
Mini-PCI TV Tuner Module

7
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PC Camera & TV
Tuner

7

If you have the optional
TV Tuner included in
your purchase, make
sure you install the TV
Tuner driver and application first. After installing the PC Camera
driver you will need to
select which device to
use with the EMAMCAP
program. Go to the Devices menu in the
EMAMCAP
program
and select the USB2.0
1.3M PC CAM device.

PC Camera Module
If your purchase includes the optional PC Camera you will need to install the device
driver for it as indicated on the following pages (make sure you install the drivers
in the order indicated in Table 4 - 1, on page 4 - 6).


Latest PC Camera Driver Information
Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.

PC Camera Driver Installation
1. Insert the PC Camera CD-ROM into the CD/DVD Drive.
2. The program will run automatically.
3. Click Next (click Continue Anyway if asked if you want to continue at any
time).
4. Click Finish > OK to restart the computer.
5. Use the Ap-Key button
to turn the PC Camera module on (the
LED will
be green).
6. Run the emAMCAP application software from the USB2.0 1.3M PC
CAM item in the Start > Programs/All Programs menu (give the computer time to find the hardware).

7 - 2 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.
1.

2.
3.
4.
5.
6.
7.
8.

Go to the Start menu and point to Settings (or click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds,
Speech, and Audio Devices in Category View).
Click Advanced in Device volume (Volume tab).
Click Options and scroll down and click Properties.
Select Realtek AC97 Audio from the Mixer Device menu.
Click Recording (button).
Click Microphone (check box) if it is not checked, and then click OK.
Make sure the Select (check box) in the Recording Control panel, under the
Microphone section, is checked (boost the volume as high as it will go).
Close the window, and then click OK.


Taking Still Pictures
You may take still pictures in the Windows
XP operating system
only.
Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.
Double-click the USB2.0
1.3M PC CAM icon.

Click Take a new picture
in the Camera Tasks box.

PC Camera Module 7 - 3

7

Modules
Figure 7 - 1
Audio Setup
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EMAMCAP
The EMAMCAP video viewer can capture video files to .avi format, and is useful
for basic general purpose video viewing and testing (a number of commercially
available programs support advanced video capture features).
1.

2.
3.

4.
5.

Run the EMAMCAP program from the Start > Programs/All Programs > USB2.0
1.3 PC Cam menu (it is recommended that you set the capture file before the
capture process - see Set Capture File below).
Go to the Capture menu heading and select Start Capture.
On the first run of the program (if you have not set the captured file) you will be
asked to choose a file name, size (see the sidebar - Pre-Allocating File Space)
and location for the captured file.
Click OK to start capturing the video, and press Esc to stop the capture.
If you wish to, you may go to the File menu and select Save Captured Video...,
choose a file name and location, and then click Open (you can view the file using
the Windows Media Player).

Set Capture File
In the EMAMCAP program you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file will
automatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).


Pre-Allocating File
Space
You may pre-allocate
the file size for the capture file in the EMAMCAP program. You can
choose to ignore this by
clicking Cancel.
Pre-allocating space on
the hard disk can improve the capture quality (particularly of large
capture files), by reducing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.
You may find it helpful to
defragment the HDD before capture.

PC Camera Module 7 - 5
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Eliminating Screen Flicker
If you find that the video screen in the EMAMCAP program is flickering, you can
try to adjust the setting in the Lighting Selection options.
1.
2.
3.
4.

Figure 7 - 2
Video Image
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Run the EMAMCAP program.
Go to Options and scroll down to select “Video Capture Filter...”.
Click Video Image (tab).
Select Florescent 50Hz, Florescent 60Hz or Incandescent in the Light dropbox.
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The Wireless LAN & Bluetooth Modules
If your purchase option includes a Wireless LAN and/or Bluetooth module, follow
the information on the following pages for instructions on installing the driver(s).
Pay careful attention to the warnings concerning the use of wireless modules aboard
aircraft, and the instructions on enabling/disabling power to the module(s).


Power Toggle for the Wireless LAN and Bluetooth Modules
You will need to enable power to the modules by using the following key combinations:
Fn + F11 = Wireless LAN Module Power Toggle
Bluetooth Ap-key
= Bluetooth Module Power Toggle
When the Wireless LAN module is powered on, the
When the Bluetooth module is powered on, the


Wireless Device
Operation Aboard
Aircraft
The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the module(s) are OFF if you are
using the computer
aboard aircraft.

LED will be green.
LED will be green.

Do not try to use the Wireless LAN module and the Bluetooth module at the same time, as
this may cause a communication conflict.

The Wireless LAN & Bluetooth Modules 7 - 7
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Wireless Device
Operation Aboard
Aircraft

7

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the module(s) are OFF if you are
using the computer
aboard aircraft.

Mini-PCI Wireless LAN Module
Before installing the Wireless LAN driver, make sure that the WLAN module is on
(the
LED will be green).
Use the WLAN module key combination Fn + F11 to toggle power to the WLAN
module. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 6.
You may have one of two (Intel or MSI) optional Mini-PCI Wireless LAN modules
supplied with your computer; depending on your purchase configuration.You will
be provided with the appropriate driver CD for your module. Insert the CD and follow the installation procedure.
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Intel WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Intel PROSet/
Wireless CD-ROM into the CD/DVD drive.
2. Click Install Software (button).
3. Click the button to accept the license and click Next > Next > OK.
4. Click OK to complete the installation.
5. You can configure the settings by going to the Intel (R) PROSet Wireless
control panel (Start > Programs/All Programs > Intel PROSet Wireless),
or by double-clicking the taskbar icon
.


User Guide
You can view the User
Guides by inserting the
Intel PROSet/ Wireless
CD-ROM and clicking
View User Guide (button) as per Figure 7 - 3.

7
Figure 7 - 3
Intel PROSet/
Wireless
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MSI 6833B WLAN Driver Installation
1. Make sure the WLAN module is powered ON.
2. Insert the Wireless LAN CD-ROM into the CD/DVD drive.
3. The program will run automatically.
4. Click Install Software (button).
5. Click Yes to accept the license agreement.
6. Click Next > Next.
7. Click Finish to restart the computer.
8. The network settings can now be configured.
9. Double-click the WLAN icon
in the taskbar to run the RaLink Wireless Utility (right-click the icon to bring up the utility menu).
10. Click Rescan to scan for available access points.
11. Select an access point and click Connect to start the access process (e.g.
Authentication and Security).
12. You can access the RaLink Wireless Utility from the Start menu (Start
menu and point to Programs/All Programs > RaLink Wireless).
To view the Help menu, click About (tab) in the RaLink Wireless Utility. Click
Help (button) to bring up the menu, and click Contents to access the links to help
contents.
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WLAN Icon

Figure 7 - 4

The WLAN icon will change color to reflect the network connection status:

WLAN Utility

Signal Strength is Good
Signal Strength is Normal
Signal Strength is Weak

7

Not Connected Yet
Wireless Module Not Detected
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Wireless Device
Operation Aboard
Aircraft
The use of any portable
electronic transmission devices aboard aircraft is usually prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

7

Bluetooth Module
Before installing the Bluetooth driver, make sure that the optional Bluetooth module is on (the
LED will be green). Use the
Ap-key to toggle power to the
Bluetooth module. Make sure you install the drivers in the order indicated in
Table 4 - 1, on page 4 - 6.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Bluetooth CDROM into the CD/DVD drive.
2. The program will run automatically.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Next > Install.
7. Click Finish > Yes to restart the computer.
8. The IVT Corporation BlueSoleil - Main Window screen appears on
restart.
9. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar icon .
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User Guide
View the BlueSoleil
User Guides from the
Help Menu (or press the
F1 key) in the IVT Corporation BlueSoleil Main Window control
panel. Click BlueSoleil
User Guides in the
Contents tab, and click
to select the appropriate
User Guide from the
panel on the right.

Figure 7 - 5
Bluetooth Control
Panel & User
Guides
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TV Tuner Remote
Point the remote at the
consumer IR transceiver to change channels
etc.

Mini-PCI TV Tuner Module
You may have one of two optional Mini-PCI TV Tuner modules supplied with your
computer, depending on your purchase configuration. The optional TV Tuner allows
you to watch TV, play music CDs, video conference and capture still images and
video on your PC.
The AverMedia M103 Hybrid (for both analog and digital inputs) or AverMedia
M102 (for analog input only) Mini-PCI TV Tuner Module comes with a remote
control unit and CDs containing the AverTV Utility software & Power DVD software.
The TV antenna jack and S-Video-In jack will only be enabled when the TV
Tuner module is installed. Make sure you install any software before connecting the TV antenna.

7

Figure 7 - 6
TV Tuner Ports
1.
2.
3.

1

Consumer IR
Transceiver
S-Video-In Jack
TV Antenna Jack

2

3
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AverMedia Mini-PCI TV Tuner Module
If your purchase includes either of the AverMedia Mini-PCI TV Tuners, then install
the driver and software as per the instructions below.

Installing the AverTV Utility Software
1. Insert the AverTV Utility CD-ROM into the CD/DVD drive.
2. Click TV Utility Software.
3. Click Yes > Next > Next (click Continue Anyway if asked to continue at
any time).
4. Click Finish.
5. Run the program from the Start > Programs/All Programs > AVer TV
menu, and select the AVer TV program, or double-click the icon on the
desktop.
Installing the Cyberlink Power DVD Software
1. Insert the Cyberlink PowerDVD CD-ROM into the CD/DVD drive.
2. Click Next > Yes > Next >........ Next.
3. Click Finish.
4. Run the program from the Start > Programs/All Programs > CyberLink
PowerDVD menu, and select the CyberLink PowerDVD program, or double-click the icon on the desktop.
5. Type in the serial number and click Activate, then run the software again.
6. See over for instructions on configuring S/PDIF audio output.


User Manual
Insert the TV Tuner
CD-ROM and doubleclick Acrobat Reader
(button) and follow the
instructions to install
the program (if you
have not already done
so). Double-click User
Manual from the menu
to access the manual.


TV Antenna
The TV antenna supplied with any TV Tuner module is intended
for indoor use only.
Please do not use your
TV Tuner module outdoors.

Mini-PCI TV Tuner Module 7 - 15
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear Digital Terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on Digital Terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

7

Setting S/PDIF for Audio Output in Cyberlink Power DVD
If you want to use the S/PDIF-Out jack for audio output in the Cyberlink Power
DVD application, then you should configure the application as follows:
1.
2.
3.
4.
5.
6.
7.

Connect the speakers to the S/PDIF-Out Jack.
Run the Power DVD application.
Right-click the screen, then scroll down and select the Configuration menu item.
Click Audio (tab).
Select SPDIF from the Speaker Environment menu.
Click OK.
The system is now set up to play the sound through the S/PDIF-Out Jack, however
note that audio output will only be played through the external speakers, and
not the system speakers.
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.
Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.
• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 6)
to see the computer’s power status.
• Connections - Check all the cables to make sure that there are no loose connections anywhere.
• Power Savings - Make sure that the system is not in Hibernate or Stand by mode by pressing the keys configured in your Power Management/Power Options (see “Configuring the Power Button” on page 3 - 8),
the Fn + F4 key combination, or power button to wake-up the system.

8

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see Table 1 - 4, on page 1 - 8).
• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display (see Table 1 4, on page 1 - 8).
• Boot Drive - Make sure there are no floppy disks in any connected drive when you start up your machine
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.
• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.
• Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 10).
• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief
notes).


Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.
• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within email attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowledge.
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• Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information which allows
you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to
make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to
make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.
• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.
• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.
• When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.
• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).
• Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems & Possible Solutions
Problem

Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator
, is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Schemes” on page 3 - 4) check its settings. You may also be using a PC Card device that is
drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 9).
Power Options have been disabled. Go to the Control Panel in Windows and re-enable the
options.
A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to save
power.
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Problem

Possible Cause - Solution

The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 9). Make sure you’re
using the correct adapter.
Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing
screen.

appears

on

The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4 (see
“Sleep Button” on page 3 - 8).
\

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations
(see Table 1 - 4, on page 1 - 8). If you’re connected to an external monitor, make sure it’s
plugged in and turned on. You should also check the monitor’s own brightness and contrast
controls.

8

The computer is set for a different display. Toggle the screen display key Fn + F7 combination
(see Table 1 - 4, on page 1 - 8). If an external monitor is connected, turn it on.
The screen saver is activated. Press any key or touch the TouchPad.
No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.
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Problem
You forget
password.

the

Possible Cause - Solution
boot

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.


Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2
- 11) to adjust.

The
compact
cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

disc

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The
DVD
regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

Problems & Possible Solutions 8 - 9

8

Troubleshooting

8

Problem

Possible Cause - Solution

The TouchPad doesn’t
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “System Power Options” on page 3 - 6). Make sure you have
enabled Hibernate mode from the control panel.

The
Wireless
LAN/
Bluetooth/PC Camera
modules
cannot
be
detected.

The modules are off. Check the appropriate LED indicator
to see if the modules are
on or off (see “LED Indicators” on page 1 - 6). If the LED indicator is off, then press the
appropriate AP-Key button/function key combination in order to enable the modules (see Table 1
- 3, on page 1 - 7/Table 1 - 4, on page 1 - 8).

The
Wireless
LAN/
Bluetooth/PC Camera
modules
cannot
be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
module).

The
PC
Camera
software
displays
a
black screen when the
EMAMCAP software is
run.

The software is using the incorrect device. If you have both the optional PC Camera and TV Tuner
modules present, make sure you install the TV Tuner driver and application first. After installing
the PC Camera driver you will need to select which device to use with the EMAMCAP program.
Go to the Devices menu in the EMAMCAP program and select the USB2.0 1.3M PC CAM device
(see “PC Camera & TV Tuner” on page 7 - 2).
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
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Ports and Jacks
Item
Built-In Microphone

Card Reader

Description
The built-in microphone allows you to record on your computer

The card reader allows you to use the following digital storage cards:
MMC (MultiMedia Card)
SD (Secure Digital)
MS (Memory Stick)
MS Pro (Memory Stick Pro)

Consumer Infrared
Transceiver

A

DC-In Jack

DVI-Out Port

The consumer infrared transceiver at the front of the computer allows the computer to
communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner (see
“System Map: Front & Rear Views” on page 1 - 9).
Plug the supplied AC/DC adapter into this jack to power your computer.

The DVI-Out (Digital Visual Interface) Port allows you to connect an external monitor, or Flat
Panel Display, to allow dual video or simultaneous display on the LCD and external monitor/FPD
(see “Display Devices & Options” on page 1 - 14). If you are using an older type of monitor you
will need to use a converter to convert the signal from DVI to VGA.
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Item

Description

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Infrared (FIR)
Transceiver

The FIR (far infrared) transceiver on the right of the computer allows the computer to
communicate with similarly equipped devices (see “Configuring the Infrared Settings for FIR”
on page 2 - 12).

Line-In Jack

The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sounds and Audio Devices
Windows control panel and
make sure the Mute box is not ticked.

Microphone-In Jack

Mini-IEEE 1394a Ports

Plug an external microphone in to this jack to record on your computer.

This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).


IEEE 1394
The Mini-IEEE 1394a ports only support SELF POWERED IEEE 1394 devices.
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Item

Description

RJ-11 Phone Jack

This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack

This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVDcapable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

Serial Port

Connect a serial type mouse to this port.

A
S-Video-In Jack

The S-Video-In jack allows video input to the computer if you have included the optional MiniPCI TV Tuner in your purchase.

7-Pin S-Video-Out Jack

Connect your television to your computer and view DVDs, VCDs or anything else your computer
can display. You will need a 7-pin S-Video plug to 4-pin S-Video jack adapter and S-Video cable
to make the connection (see “7-Pin S-Video-Out Jack” on page 1 - 9).
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Interface (Ports & Jacks)
Item

Description

TV Antenna Jack

Use this jack to connect the TV antenna if you have included the optional Mini-PCI TV Tuner in
your purchase.

USB 2.0/1.1 Ports

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

A
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Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 14.


Video Card Options

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6.

1. Double-click VGA.
OR
Click Start (menu) > Run... and navigate (Browse..) to
D:\Drivers\01VGA\setup.exe and click OK.
2. Click Next (click Continue Anyway if asked if you want to continue at any
time).
3. Click Finish to restart the computer.

Note that card types,
specifications and drivers are subject to continual
updates
and
changes. Check with
your service center for
the latest details on video cards supported.
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3D Ap-Key Button
The system will default to high performance video when powered by the AC/DC
adapter (the 3D Ap-Key button
will be illuminated in blue when in high performance video mode).
If you switch from AC power to battery power the system will automatically change
to a lower performance video mode setting (the 3D Ap-Key button will no longer
be illuminated in blue). High Performance Video can not be enabled when the
system is battery powered.

Figure B - 1
3D Ap-Key Button

The system will retain in memory the last known video performance setting if you
switch back from battery to AC power.

1. 3D Ap-Key Button

1

B
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NVIDIA Display Properties
More advanced video configuration options are provided in the NVIDIA Display
Properties control panel tab.
1.
2.
3.
4.

Open the Display Properties (see page 1 - 14) control panel.
Click Advanced (button).
Click GeForce Go.... (tab).
Click Additional Properties (or click the icon ) to make any video adjustments.


GeForce Go... Control Panel
To access the GeForce Go... control panel
from the desktop; right-click the desktop, then
point to NVIDIA Display and click Laptop Display.


Taskbar Icon
Click the NVIDIA taskbar icon
then click
NVIDIA Display > Laptop Display to bring up
the GeForce Go... control panel.
If you cannot see the
tray icon
, go to the
GeForce Go... control
panel tab and select the
Tools item from the Additional
Properties
menu. Click the tickbox
“Enable taskbar icon”,
and apply the settings.

B
Figure B - 2
Enable Taskbar Icon
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Additional Properties
The items listed in the Additional Properties window allow you to configure your
display(s). If the items do not display you can either click the Additional Properties
button, or click the icon .

Figure B - 3
Additional
Properties

B

Click pin icon to push pin in
to keep the menu open.

Some screen examples are shown on the following page.

B - 4 NVIDIA Display Properties

NVIDIA Video Driver Controls
You may make changes to the Display Settings, Color Correction, Video Overlay,
Resolutions, Refresh Rates and Screen Rotation by clicking the appropriate tab and
adjusting the setting.


Help Menus
Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.
Click the “What’s This?”
button to bring up the
help menu.

Figure B - 4
Right-click on a control panel
item to bring up a Help menu
(see sidebar).

Screen Examples

B
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NVIDIA nView Desktop Manager


nView Desktop
Manger from
Additional Properties
You can view the nView
Desktop Manager control panels from the Additional
Properties
window.

The nView Desktop Manager allows quick access to control panels for features
such as Desktop Management, Profiles, Hot Keys etc. The Control panel may be accessed as follows.
1.
2.

Click Start, point to Settings and click Control Panel (or just click Control Panel).
Double-click NVIDIA nView Desktop Manager (icon) - Click "Switch to Classic
View" from the left of the menu if you are in Category View.
Click the Enable button to display the
Desktop Management options menu.

Select Additional Properties from the GeForce Go... control
panel. Click the Desktop Management menu
item and click the Enable button to display
the options.

B

Figure B - 5
Desktop Manager
Control Panel
The Display Wizard helps you to quickly configure
any attached displays after enabling
nView Desktop Manager.
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NVIDIA Video Driver Controls
Additional configuration controls and tools are available from the nView Desktop
Manager.

Figure B - 6
nView Desktop
Manager Screen
Examples

B

Click the taskbar icon to bring up the menu
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Multi-GPU Display
Mode Support
SLI Multi-GPU supports
only single display
mode (disable SLI MultiGPU before switching to
Clone
or
Dualview
modes).

Figure B - 7
SLI multi-GPU
Control Panel
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SLI Multi GPU
This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs in a single system. SLI Multi GPU needs to be enabled/disabled from the SLI multi-GPU menu
item.
1.
2.
3.

Go to Additional Properties in the GeForce Go... control panel tab (see page B - 3).
Select SLI multi-GPU.
Click the box to enable/disable SLI multi-GPU and click Apply or OK.

NVIDIA Video Driver Controls

Display Devices
Besides the built-in LCD, you can also use an external monitor/flat panel display or
TV as your display device. The following are the display options:
1.
2.
3.
4.

The built-in LCD.
An external monitor connected to the DVI-Out Port (may require DVI to VGA
converter).
A flat panel display connected to the DVI-Out Port (may require DVI to VGA
converter).
A TV connected to the S-Video-Out jack.


Monitor and TV Tuner
If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.


Display Wizard
Use the Display Wizard
in the Desktop Management window to
quickly setup and configure any attached displays (see Figure B - B
- 5 on page B - 6).

Multi-GPU Display
Mode Support
SLI Multi-GPU supports
only single display
mode (disable SLI MultiGPU before switching to
Clone
or
Dualview
modes).

Display Devices B - 9
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Function Key
Combination
You can use the Fn + F7
key combination to toggle through some display options:
• Notebook Only
• External Display Only

Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the DVI-Out Port at
the rear of the computer.
1.
2.
3.
4.
5.

Attach your external monitor to the DVI-Out Port (or TV to the S-Video-Out jack),
and turn it on.
Go to Additional Properties in the GeForce Go... Properties control panel tab (see
“NVIDIA Display Properties” on page B - 3).
Select nView Display Settings (if nView Display Settings do not appear, close
and reopen the control panel).
Select the display mode from the nView Display Mode drop box (see page B - 12).
Select Apply and click Yes to confirm the settings.

Make sure you give the
displays enough time to
refresh.


Device Settings

Figure B - 8

B

nView Display
Settings

Click the display icon to
select it, then click the
Device Settings button
to make any adjustments for the selected
display
(including
Screen Resolutions &
Refresh Rates).

B - 10 Attaching Other Displays
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6.

Select the display option from the Primary Display/ Secondary Display dropbox.
If you have a TV and external monitor/flat panel display attached you will have a
number of available options (see sidebar). Select and Apply the appropriate
option.


nView Display
Mode Options
The display options
listed under the Primary/Secondary display
drop boxes will differ
according to the displays attached, and
the Display Mode
chosen.
Click Detect Displays
(button) to automatically update the attached
display
information.

Figure B - 9
7.

8.

Click the monitor icon to select it, and then click the Device Settings button to
make any adjustments for the selected display (including Screen Resolutions &
Refresh Rates).
Click Apply to confirm any setting changes.

Primary/
Secondary Display
Dropbox

Attaching Other Displays B - 11
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Display Wizard
Use the Display Wizard
in the Desktop Management window to
quickly setup and configure any attached displays (see Figure B - B
- 5 on page B - 6).

Multi-GPU Display
Mode Support

B

SLI Multi-GPU supports
only single display
mode (disable SLI MultiGPU before switching to
Clone
or
Dualview
modes).

Display Modes
Single Display Mode
Only one of your displays is used.
Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content and each
display device can be configured independently.
Dualview Mode
Dualview Mode treats both connected displays as separate devices, and they act as
a virtual desktop resulting in a large workspace. When Dualview is enabled, you can
drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.

B - 12 Display Modes
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To Enable Extended Desktop (Windows Display Properties)
1.
2.
3.
4.
5.

Attach your external monitor to the external monitor port and turn it on.
Click Start, point to Settings (or click Control Panel) and click Control Panel (if
you are in Category View choose Appearance and Themes).
Double-click Display (icon).
Click Settings (tab).
Click the monitor icon (e.g. 3 ), and make sure you have checked “Extend my
Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor
icon (e.g. 3 ) to be able to select
the option to extend the desktop
on to it.
In this example the Primary monitor 1 is on the left, the secondary
display 3 is on the right.


Display Settings
Extended Desktop
Use the control panel to
drag the monitors to
match the physical arrangement you wish to
use.
You can drag any icons
or windows across to either display desktop,
which makes it possible
to have one program
visible in one of the displays, and a different
program visible in the
other display.

B
Figure B - 10
Display Properties
(Extended Desktop)
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Enabling TV Display

Detect Displays

To display desktop images on a TV, connect the TV to your computer by using an
S-Video cable from the TV to the S-Video-Out jack at the rear of the computer.

To get a full range of options from the Device
Settings menu click the
Detect Displays button.
Click to select the TV
icon, then click the Device Settings button.

You will need to enable the TV display from the nView Display Settings tab (see
“Attaching Other Displays” on page B - 10). The TV will appear as a display option
(select the display option from the Primary Display/ Secondary Display dropbox)
when attached to the S-Video-Out jack.

Figure B - 11
TV Device Settings
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NVIDIA Video Driver Controls
Click the TV display icon to select it and set the TV format from the Select TV Format menu. The Advanced option at the bottom of the Select TV Format menu allows you to select TV format by country if you are unsure of your TV format.
Device Adjustments (Device Settings menu) allows you to make changes to the TV
output.

Figure B - 12
TV Settings & TV
Output

B
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Appendix C: Specifications

Latest Specification Information
The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed or updated due to the manufacturer's release schedule. Check with your
service center for details.
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Specifications
Feature
Processor Types

Specification
Mobile AMD Turion™ 64 Processor (35W),
754-pin Micro-PGA Package
Models ML-28/ ML-32
Mobile AMD Turion™ 64 Processor (35W),
754-pin Micro-PGA Package
Models ML-30/ ML-34/ ML-37/ ML-40/ ML-42/
ML-44
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(µ0.09) 0.09 Micron Silicon-On-Insulator (SOI)
Process Technology, 512KB L2 Cache
1.6GHz/ 1.8GHz
(µ0.09) 0.09 Micron Silicon-On-Insulator (SOI)
Process Technology, 1MB L2 Cache
1.6GHz/ 1.8GHz/ 2.0GHz/ 2.2/ 2.4GHz

Mobile AMD Turion™ 64 Processor (25W),
754-pin Micro-PGA Package
Models MT-28/ MT-32

(µ0.09) 0.09 Micron Silicon-On-Insulator (SOI)
Process Technology, 512KB L2 Cache
1.6GHz/ 1.8GHz

Mobile AMD Turion™ 64 Processor (25W),
754-pin Micro-PGA Package
Models MT-30/ MT-34/ MT-37/ MT-40

(µ0.09) 0.09 Micron Silicon-On-Insulator (SOI)
Process Technology, 1MB L2 Cache
1.6GHz/ 1.8GHz/ 2.0GHz/ 2.2GHz

Core Logic

nVIDIA nForce4 SLI Chipset

LCD

19" WSXGA+ (1680 * 1050) TFT LCD

Security

Security (Kensington® Type) Lock Slot

Memory

Two 64-bit wide DDR Data Channels
Two 200 Pin DDR SODIMM Sockets Supporting DDR 400/333 MHz
Expandable up to 2GB (Compatible with 1024MB, 512MB, 256MB DDR 400/333 MHz Modules)

BIOS

One 512KB Flash ROM
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BIOS Password

Phoenix BIOS

Specifications
Feature
Video Card
Options

Storage Options

Specification
NVIDIA GeForce Go 7800 GTX
Dual/Single NVIDIA G70-GTX High Performance
Graphic Chip
512MB (Dual VGA) or 256MB (Single VGA)
DDR-III (DDR3) Video RAM On Board
256 bit Memory Interface
PCI Express * 8 by 2
Supports DirectX® 9, SM 3.0 (NVIDIA Only)
Modular Design


Video Card Options
Note that card types, specifications and drivers are subject to continual updates and
changes. Check with your service center for
the latest details on video cards supported.

One Changeable 2.5" 9.5mm (h) Serial-ATA II (SATA II) Hard Disk Drive
One Changeable Optical Device Bay - 12.7 mm (h) for Optical CD/DVD Device Drive Options
(see“Optional” on page C - 5)

Card Reader

Built-In 4-in-1 Card Reader (SD/ MMC/ MS/ MS Pro)

Audio

SRS WOW Surround Sound Technology
Inside
3D Enhanced Sound System
Sound Blaster PRO™ Compatible

Keyboard &
Pointing Device

Full Size Winkey Keyboard with Numeric Keypad

Virtual 4-Channel Sound System
S/PDIF Digital Output (5.1 CH)
Built-In Microphone
4 * Built-In Speakers
Built-In Sub Woofer
Built-In TouchPad (Scroll Functionality Included)
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Specifications
Feature
PCMCIA

One Type II PCMCIA 3.3V/5V Socket

I/O Ports

Five USB 2.0 Ports
One Mini-IEEE1394a Port
One Serial Port
One Infrared Transceiver (IrDA 1.1 / FIR)
One DVI-Out Port
One Headphone/Speaker-Out Jack
One Microphone-In Jack
One S/PDIF Out Jack
One Line-In Jack for Audio Input

Communication

C

Specification

Infrared Transceiver
Infrared Transfer 1cm ~ 1M Operating
Distance
115.2K bps SIR
4M bps FIR
IrDA 1.1 Compliant
10/100/1000 BASE-TX Fast Ethernet LAN on
board (PCIe Interface)
Integrated 56K AC’97 Modem (V.92 Compliant)
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One RJ-11 Jack (Modem)
One RJ-45 Giga LAN (Local Area Network) Jack
One DC-In Jack
One 7-Pin S-Video-Out Jack for TV & HDTV
Output (requires adapter)
One TV Antenna (Analog/Digital) Jack (Functions
with Optional TV Tuner Module)
One Consumer Infrared Transceiver (Functions
with Optional TV Tuner Module)
One S-Video-In Jack for Video Input (Functions
with Optional TV Tuner Module)
802.11 a/b/g Mini-PCI Wireless LAN Module
Bluetooth™ Class II V1.2 USB 2.0 Module
1.3M Pixel USB 2.0 Video Camera Module
(Factory Option)
TV Tuner Module (either analog only OR analog/
digital options) with Mini-PCI Interface (Factory
Option)

Specifications
Feature

Specification

Operating
Systems
Supported

Windows XP SP2

Power
Management

Supports ACPI 2.0

Power

Full Range AC/DC Adapter – AC in 100 ~ 240V, 47 ~ 63Hz DC Output 20V, 11 A (220 Watts)

Supports Hibernate/Stand by Modes

Easy Changeable 12-Cell Smart Lithium-Ion 6600mAH / 14.8V Main Battery
Environmental
Spec

Temperature
Operating:
Non-Operating:

Physical
Dimensions &
Weight

476mm (w) * 343mm (d) * 29.5 ~ 47.8mm (h)

6.6kg with 12-Cell Battery

Optional

Optical Drive Module Options:

TV Tuner Module (either analog only OR analog/
digital options) with Mini-PCI Interface (Factory
Option)

5°C ~ 35°C
-20°C ~ 60°C

DVD/CD-RW Combo Drive Module
DVD-Dual Drive Module
DVD-Super Multi Drive Module

Relative Humidity
Operating:
Non-Operating:

20% ~ 80%
10% ~ 90%

1.3M Pixel USB 2.0 Video Camera Module
(Factory Option)
DVD Software Player
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